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1. Dulezité

Tato elektronickd uZivatelskd prirucka je
uréena pro kazdého uZivatele tohoto monitoru
Philips. Pred pouZzivdnim monitoru si prectéte
tuto uZivatelskou prirucku. Obsahuje ddlezité
informace a poznamky k pouzivani vaseho
monitoru.

Zaruka Philips je platnd, pokud je vyrobek
pouzivdn pro navrzenou potrebu v souladu

s ndvodem a po prilozen( origindlu faktury
nebo pokladnim dokladem, oznacujicim datum
ndkupu, jméno prodejce a modelové a vyrobnf
¢islo vyrobku.

1.1 Bezpecnostni opatreni a udrzba

€ Varovani

Pouziti kontrol, Uprav nebo postupl jinym

zpUsobem nez je stanoveno v této dokumentaci

muZze vést k ohroZenf Sokem, elektrickym a/

nebo mechanickym rizikdim.

Prectéte si a dodrzujte tyto instrukce pri

zapojovdani a pouzivan( vaseho PC monitoru.

Pouzivani

*  Nevystavujte monitor pffimému slune¢nimu
zdr'eni, velmi silnym jasnym svétlim a
udrzujte jej mimo dosah jinych zdrojd tepla.
Dlouhé vystaveni tomuto typu prostredf

muze mit za ndsledek zménu barev a
poskozeni monitoru.

*  Odstrarite veskeré predméty, které by
mohly spadnout do vétracich otvord nebo
zabranit dostatecnému chlazeni elektroniky
monitoru.

*  Nezakryvejte vétracl otvory ve skfifice.

*  Umlistéte monitor na takové misto, ze
kterého bude elektrickd zdstrcka a zdsuvka
snadno pristupna.

* Jestlize jste vypnuli monitor odpojenim
napdjectho kabelu nebo kabelu napdjeciho
adaptéru, pred pripojenim kabelu pockejte
6 sekund, aby monitor fungoval normdiné.

* Vidy pouzivejte napdjeci kabel schvéleny
spolecnostf Philips. Pokud napd jeci kabel
chybi, obratte se na nejblizsi servisni
stredisko. (Viz informace o strediscich
zdkaznické péce)

*  Béhem pouzivdni nevystavujte monitor
nadmémym otresim nebo ndrazim.

*  Pfi pouzivani nebo premistovéni do
monitoru nekopejte a zabrarite pripadnému
padu.

Udrzba

*  Aby byl monitor chrdnén pred moznym
poskozenim, nevyvijejte na panel LCD
nadmeémy tlak. Pri premistovani zvedejte
monitor za rdm; pri zveddni monitoru
nesahejte rukou nebo prsty na panel LCD.

* Nebudete-li monitor delsf dobu pouzivat,
odpojte jej ze zasuvky.

* Pred ociSténim mime navihéenym
hadrfkem monitor odpojte ze zdsuvky.
Je-li vypnuté napdjent, Ize obrazovku otrit
suchym hadrikem. K ¢isténi monitoru nikdy
nepouzivejte organickd rozpoustédla, jako
napfiklad alkohol nebo Eisti¢e s obsahem
¢pavku.

» Zabrarite nebezpedf Urazu elektrickym
proudem nebo trvalého poskozenf
monitoru a chrarite monitor pried prachem,
destém, vodou nebo nadmérné vihkym
prostredim.

* Pokud dojde k namoceni monitoru, co
nejdrive jej osuste suchym hadrikem.

*  Vnikne-li do monitoru cizf ldtka nebo voda,
ihned vypnéte napdjeni a odpojte napdjecl
kabel. Odstrarite cizf ldtku nebo vodu
z monitoru a odeslete jej do servisniho
strediska.

*  Monitor neskladujte ani nepouZzivejte
na mistech vystavenych teplu, pfimému
slune¢nimu zdr'eni nebo extrémnim
teplotdm.

*  Chcete-li zachovat optimdlni vykonnost
monitoru a prodlouZit jeho Zivotnost,
pouZivejte jej na misté, které splfiuje
ndsledujici rozsahy teplot a vihkosti.



* Teplota: 0-40°C 32-95°F
e Vlhkost: 20-80% relativni vihkosti

Dulezité informace pro vypaleni obrazu/
zdvojeného dosvitu

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky. Bude-li
na vasem monitoru zobrazen neménici
se staticky obsah, vzdy aktivujte aplikaci
pro pravidelnou obnovu obrazovky.
Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazenf
duchd.
, Vypéleni*, ,dosvit" nebo ,zobrazenf
duchd" je dobre zndmy jev u technologie
panell LCD. V mnoha pripadech ,vypdleni,
,,dosvit"* nebo ,,zobrazeni duchl* postupné
zmizi po urcité dobé mimo provoz.

(D Vystraha

Selhanf aktivace sporic¢e obrazovky nebo aplikace
pro pravidelné aktualizovdni obrazovky mdze mift
za ndsledek vdzné priznaky ,vypdleni*, , dosvitu"
nebo , zdvojeného dosvitu®, které nezmizi a
nelze je opravit. Na vySe uvedené poskozen( se
nevztahuje zdruka..

Servis

* Kyt pldsté mdze oteviit pouze kvalifikovany
servisni pracovnik.

* Pokud je pro opravu vyzadovana
dokumentace nebo integrace, obratte se
na nejblizsi servisnf stredisko. (Viz kapitola
,,Stredisko zdkaznické péce')

* Informace o preevdzeni najdete v ¢ésti
,, Technické Udaje".

*  Neponechdvejte monitor v auté nebo v

zavazadlovém prostoru auta na primém
slunci.

© Poznimka

Pokud monitor nefunguje spravné nebo pokud
si nejste jisti, jaké kroky je treba provést po
provedeni pokynU v této prirucce, obrat'te se na
servisniho pracovnika.

1.2 Vysvétleni zapisu

Nasledujici pododdily popisujf zplsob zdpisu,
ktery se pouzivd v této prirucce.

Poznamky, upozornéni a vystrahy

Na strdnkdch této prirucky mizete narazit na
text, ktery je opatfeny symbolem a je vytistén
tucné nebo kurzivou. Takové useky obsahujf
pozndmky, upozornénf a vystrahy. Jejich pouZitf
je nasledujict:

€& Pozniamka

Tento symbol oznacuje dlleZité informace a
ndvrhy, které poméhajf Iépe vyuzit pocitacovy
systém.

© Upozornéni

Tento symbol oznacuje informace, které
objasniujf, jak se vyhnout moznému poskozenf
zafizeni nebo ztrdté dat.

D Vystraha

Tento symbol oznacuje nebezped( télesného
ubliZzenf a vysvétluje, jak se danému problému
vyhnout.

Nekteré vystrahy se mohou objevit v riizné
podobé a nemusf byt uvozeny symbolem.V
takovém pripade je konkrétni vyznacenf vystrahy
nar{zeno Uradem pro regulaci.



1.3 Likvidace produktu a obalového
materialu

Likvidace elektrickych a elektronickych
zarizeni - WEEE

This marking on the product or on its
packaging illustrates that, under European
Directive 2012/19/EU governing used electrical
and electronic appliances, this product may
not be disposed of with normal household
waste.You are responsible for disposal of

this equipment through a designated waste
electrical and electronic equipment collection.
To determine the locations for dropping off
such waste electrical and electronic, contact
your local government office, the waste disposal
organization that serves your household or the
store at which you purchased the product.

Your new monitor contains materials that can
be recycled and reused. Specialized companies
can recycle your product to increase the
amount of reusable materials and to minimize
the amount to be disposed of.

All redundant packing material has been
omitted. We have done our utmost to make the
packaging easily separable into mono materials.

Please find out about the local regulations on
how to dispose of your old monitor and packing
from your sales representative.

Taking back/Recycling Information for
Customers

Philips establishes technically and economically
viable objectives to optimize the environmental
performance of the organization's product,
service and activities.

From the planning, design and production
stages, Philips emphasizes the important of
making products that can easily be recycled. At
Philips, end-of-life management primarily entails
participation innational take-back initiatives

and recycling programs whenever possible,
preferably in cooperation with competitors,
which recycle all materials (products and
related packaging matenial) in accordance with
all Environmental Laws and taking back program
with the contractor company.

Your display is manufactured with high quality
materials and components which can be
recycled and reused.

To learn more about our recycling program
please visit

http://www.philips.com/sites/philipsglobal/
about/sustainability/ourenvironment/
productrecyclingservices.page


http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page
http://www.philips.com/sites/philipsglobal/about/sustainability/ourenvironment/productrecyclingservices.page

2. Sestaveni monitoru 2] Namontujte stojanek podstavce

1. Umistéte monitor obrazovkou dold na
mékky a hladky podklad, aby nedoslo k

2.1 Instalace poskrabdni obrazovky.
2. Pripojte/nasurite sloupek podstavce k
El Obsah krabice monitoru tak, aby zacvakl na misto.
=
Quick
Start

3. Uchopte monitor obéma rukama a
pripevnéte stojdnek podstavce do sloupku
podstavce.

*V zavislosti na zemi



E Pripojeni k pogitadi 2.2 Ovladani monitoru

223V5LSB/223V5LSW/223V5LSB2
(1] Popis vyrobku z ¢elniho pohledu

PHILIPS

X2}
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(1] Vstup stidavého napdjenf %

© VstupVGA 223V5L:
© Vstup DVI-D (k dispozici pro vybrané
modely) (5}

o Z3amek proti krddeZi Kensington
223V5LHSB/223V5LHSW/223V5LHSB2 AUTO/VY  E0/A o/4 B/0K 10}

I | [\ I I

(7] (6] o © (2] o

o o [Sourk ZAPNUTI aVYPNUTI
napdjeni monitoru.
[5) o
g Slouzi ke vstupu do nabidky
@ &/0K|0sD.
Potvrzen( nastaveni OSD.
oS k né *edchon!
© Vstup stiidavého napdjent 0 4 zr%i?rﬁ ga;gatu na predchozi
© Vstup VGA . :
O Vstup HDMI O | & |Nastaveni trovné jasu.
O \ystup zvuku HDMI © | A ¥ [Slous k tpravém nabidky OSD.
(k dispozici pro vybrané modely)

6 Z3amek proti krddezi Kensington O | EX Zmena formétu zobrazent
Pfipojeni k poditai ©@ | AUTO |Automatické nastavenf monitoru.

1. Pevné pripojte napdjeci kabel k zadnf strané
monitoru.

2. Vypnéte pocitac a odpojte jeho napdjecl
kabel.

3. Pripojte signdlovy kabel monitoru do video
konektoru na zadnf strané pocitace.

4. Zapojte napdjeci kabel pocitace a monitoru
do nejblizsi zasuvky.

5. Zapnéte pocita¢ a monitor: Jestlize se
na monitoru objevi obraz, instalace je
dokoncena.



2] Popis zobrazeni funkci na obrazovce

rdmecku monitoru pohybovat kurzorem a

stisknutim OK potvrdit vybér nebo zménu.

Co je nabidka na obrazovce (OSD)?

Funkci nabidky obrazovky (On-Screen Display, Nabidka OSD

OSD) jsou vybaveny viechny monitory
LCD Philips. Umozriuje koncovému uzivateli
upravovat vlastnosti obrazovky nebo vybirat
funkce monitoru prfmo prostrednictvim
zobrazeného okna s pokyny. Nize je uveden
priklad prijemného rozhrani obrazovky:

Main menu

— Input

223VS5LHSB/223V5LHSW/223V5LHSB2:

— Picture

— Audio

— Color
— Language
223V5LSB/223V5LSW/223V5LSB2
(pro model 1A): [— OSD Settings
III“IIHIIII‘I 100
< LRRnnnnn so
. of —— Setup

Zakladni a jednoduché pokyny k ovladacim
tlacitkdm

Ve vySe uvedené nabidce obrazovky OSD
mazete stisknutim tlacitek ¥ A na prrednim

Sub menu

-

L

(available for selective

-

VGA

NiZe je uveden celkovy pohled na strukturu
OSD. Tento prehled mlzete vyuzit, budete-li
chtit pozdéji prozkoumat riznd nastavent.

DVI (available for selective models)

HDMI (available for selective models)

Picture Format
Brightness

Contrast
SmartContrast

Over scan

—— Wide Screen, 4:3

0~100
0~100
On, Off
On, Off

(available for selective models)

Volume
Mute

models)

Color Temperature ——

sRGB
User Define

=

0~100
On, Off

6500K, 9300K

Red: 0~100
Green: 0~100
Blue: 0~100

English,Espafiol,Francais,Deutsch,ltaliano,
Portugués,Pycckui, & 1 3, Tiirkge,

Nederlands, Svenska, Suomi, Polski, Ce&tina

8t=20{, BAEE, Maryar, YkpaitcbKa,

Portugués do Brazil EN\nvIkr| (mpoaipeTikoc),

Zf e S (FTIE)

r— Horizontal

Vertical
Transparency
OSD Time Out

Auto

H. Position
V. Position
Phase
Clock

Resolution Notification

Reset

Information

0~100

0~100

Off, 1,2,3,4

5s, 10s, 20s, 30s, 60s

— 0~100
— 0~100
— 0~100
— 0~100
— On, Off
— Yes, No



El Poznamka k rozligeni

Tento monitor je urcen pro optimdini vykon
pri nativnim rozliseni 1920 x 1080 pri 60 Hz.
Kdyz je monitor zapnut pfi jiném rozlisenf, na
obrazovce se zobrazi vystraha: Pro optimalni
vysledek pouzijte rozliseni 1920 x 1080 pri 60
Hz.

Zobrazovan( vystrahy na nativn( rozlisenf Ize
vypnout v asti Setup (Nastaveni) v nabidce
OSsD.

a Fyzické funkce
Naklon

2.3 Odpojte stojanek podstavce a
podstavec

Bl Demontaz stojanku podstavce

Nez zacnete demontovat podstavec monitoru,

postupujte podle pokynd nize, aby se zabranilo

jakémukoli moznému poskozeni nebo zranént.

1. Umistéte monitor obrazovkou dold na
mékky podklad, aby nedoslo k poskrabanf
obrazovky.

2. Stisknéte zajistovaci svorky a oddélte
stojdnek podstavce od sloupku podstavce.

3. Pro odpojenf sloupku podstavce stisknéte
uvolfiovacf tlacitko.




© Poznimka

Tento monitor je kompatibilni's 100mm x
100mm montdznim rozhranim kompatibilnim
se standardem VESA.

PRIUPS

109mm

100mm




3. Optimalizace Obrazu

3.1 SmartContrast

E Cojeto?

Jedinecnd technologie, kterd dynamicky analyzuje
zobrazeny obsah a automaticky optimalizuje
kontrastn pomér monitoru LCD pro maximdln{
vizudlni Cistotu a pozitek ze sledovani. Zvysuje
podsviceni pro jasnéjsi, ostr'ejsi a jasnéjsi obraz
nebo snizuje podsviceni pro jasné zobrazenf
obrazu s tmavym pozadim.

E1 Proé to potrebuii?

Zadéte nejvy¥f vizudlni gistotu a pohodli
sledovan( jakéhokoli typu obsahu. SmartContrast
dynamicky f{di kontrast a upravuje podsvicenf
pro jasné, ostré a jasné zobrazeni her a videa
nebo pro zobrazenf jasného, citelného textu
pro kancelarskou praci. Omezenim spotreby
monitoru Setrfte ndklady a prodluzujete zZivot
vaseho monitoru.

E Jak to funguje?

Po aktivaci bude funkce SmartContrast v
redlném Case analyzovat zobrazeny obsah a
upravovat barvy a ridit intenzitu podsviceni. Tato
funkce bude dynamicky vylepSovat kontrast pro
skvély zdzitek pri prohlizeni fotografif nebo hranf
her.

3.2 Philips SmartControl Lite

Novy software SmartControl Lite od
spolecnosti Phillips umozriuje ovlddat monitor
prostrednictvim snadno pouzitelného grafického
rozhranf na obrazovce. Slozita nastaven jsou
minulosti, protoze tento uzivatelsky prijemny
software vds provede jemnym vyladénim
rozlisent, kalibraci barev, nastavenim frekvence/
faze, nastavenim bilého bodu RGB atd.

Tento software zaloZeny na pritazlivych
animovanych ikondch kompatibilni se systémem
Windows , ktery je vybaven nejnovejsi
technologil v jddrovém algoritmu pro rychlé

zpracovani a odezvu, je pripraven rozsitit vasi
zkusenost s monitory Philips!

Instalace

Postupujte podle pokynd a dokoncete
instalaci.

Mdzete spustit po dokonceni instalace.
Chcete-li spustit pozdéji, mizete klepnout
na zastupce na pracovni plose nebo na
panel nastrojd.

Prvni spusténi —Wizard (Privodce)

Pri prvnim spusténi po instalaci prejde
SmartControl Lite automaticky na Wizard
(Privodce).

Tento prdvodce vds provede podrobnym
nastavenim vykonu monitoru.

Privodce mlzete rovnéz spustit pozdéji z
nabidky Plug-in (Zdsuvny modul).

Daldi moznosti mlzete nastavit bez
pravodce prostrednictvim podokna
Standard (Standardni).



B3 Spusténi s podoknem Standard
(Standardni):

Nabidka Adjust (Nastaveni):

* Nabidka Adjust (Nastaveni) umozriuje
upravit Brightness (Jas), Contrast (Kontrast),
Focus (Ohnisko), Position (Poloha) a
Resolution (Rozliseni).

*  Muizete postupovat podle pokynd a provést
nastaven.

*  Cancel (Storno) vyziva uzivatele, chcete-li
ukoncit instalaci.

10



Nabidka Color (Barva):

Nabidka Color (Barva) umozriuje upravit
RGB, Black Level (Uroveﬁ cerné), White
Point (Bily bod), Color Calibration (Kalibrace
barev).

MU0Zete postupovat podle pokynt a provést
nastaven.

V nésledujicl tabulce vyhledejte polozku
podnabidky na zédkladé vaseho vstupu.
Priklad pro Color Calibration (Kalibrace
barev)

11



1. Tlacitko ,,Show Me" (Predvést) spustf
vyukovy program pro kalibraci barev.

2. Start (Spustit) — zahdjf sekvenci kalibrace
barev o 6. krocich.

3. QuickView (Rychlé zobrazeni) nacte
zobrazen( pred/po.

4. Chcete-li se vratit na hlavnf strdnku Color
(Barva), klepnéte na tlacitko Cancel
(Storno).

5. Enable color calibration (Povolit kalibraci
barev) — ve vychozi konfiguraci je zapnuto.
Pokud tato polozka nenf zaskrtnuta, kalibraci
barev nelze provést a tlacitka rychlé
zobrazeni nejsou k dispozici.

6. Na kalibracni obrazovce musf byt zobrazeny
informace o patentech.

Calibration Screen (Obrazovka kalibrace)
prvni barvy:

»  Tlacitko Previous (Predchozi) je
deaktivovdno az na obrazovku druhé barvy.

»  Tlacitko Next (Dals() slouzi k prechodu na
nasledujici cil (6 cild).

»  Tlacitko Konecny slouzi k prechodu na File
> Presets (Soubor > podokno Predvolby).

»  Tlacitko Cancel (Storno) slouzi k ukoncenft
uzivatelského rozhrani a k ndvratu na
strdnku zdsuvnych moduld plug-in.

Options>Preferences (Moznosti>Predvolby) —
Tato moZznost bude aktivni pouze po vybéru
polozky Preferences (Predvolby) v rozeviracf
nabidce Options (MozZnosti). Na nepodporova-
ném zobrazovacim zarizeni s podporou DDC/
Cl jsou k dispozici pouze karty Help (Ndpovéda)
a Options (MoZnosti).

Zobrazi nastaven( aktudlnich predvoleb.
Zaskrtnuté tlacitko aktivuje funkci.
Zaskrtdvaci policko je prepinac.

Polozka Enable Context Menu (Povolit
mistni nabidku) na pracovni plose je ve
vychozi konfiguraci zaskrtnutd (Zapnuto).
Po aktivaci polozky Enable Context

Menu (Povolit mistni nabidku) se zobrazf
vybéry SmartControl Premium pro funkce
Select Preset (Vybrat predvolbu) a Tune
Display (Ladéni zobrazeni) na pracovn{
plose klepnutim pravym tlacitkem mysi na
mistni nabfdku. Volbou moZznosti Disabled
(Deaktivovdno) bude polozka SmartControl
Premium odstranéna z mistni nabidky
pravym tlacitkem mysi.

Polozka Enable Task Tray (Povolit ikonu na
hlavnim panelu) je ve vychozi konfiguraci
zaskrtnutd (Zapnuto). Po aktivaci polozky
Povolit mistnf nabidku se zobrazi nabidka
SmartControl Lite na hlavnim panelu.
Klepnutim pravym tlacitkem mysi na ikonu
na hlavnim panelu se zobrazi moznosti
nabidky Help (Ndpovéda), Technical
Support (Odbornd pomoc), Check for
Update (Vyhledat aktualizace), About

(O aplikaci) a Exit (Konec). Kdyz je
deaktivovdna polozka Enable task tray menu
(Povolit nabidku na hlavnim panelu), ikona
na hlavnim panelu zobrazuje pouze moznost
EXIT (KONEC).



* PoloZka Run at Startup (Spustit pri startu) je
ve vychoz( konfiguraci zaskrtnutd (Zapnuto).
Kdyz je tato polozka deaktivovdna, funkce
SmartControl Lite se nespustf pri startu
nebo nebude na hlavnim panelu. Funkci
SmartControl Lite Ize spustit pouze
prostrednictvim zdstupce na pracovni
plose nebo prostrednictvim souboru
programu. Kdyz toto poli¢ko nenf zaskrtnuté
(Deaktivovdno), zddnd predvolba nastavend
pro spusténi pri startu nebude nactena.

* Enable transparency mode (Aktivovat rezim
prahlednosti) (Windows 7/8, Vista, XP).
Vychozi nastaven( je 0 % neprihlednost.

Options>Input (Moznosti>Vstup) — Tato
moznost bude aktivni pouze po vybéru
polozky Input (Vstup) v rozeviraci nabidce
Options (Moznosti). Na nepodporovaném
zobrazovacim zarizeni' s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda)
a Options (Mo#nosti). Zadné dal¥f karty funkce
SmartControl Lite nejsou k dispozici.

» Zobrazi podokno s pokyny Source (Zdroj)
a nastaven( aktudiniho zdroje vstupu.

* U zobrazovacich zarizen( s jednim vstupem
nenf toto podokno zobrazeno.
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Options>Audio (Moznosti>Zvuk) — Tato
moznost bude aktivni pouze po vybéru polozky
Audio (Hlasitost) v rozeviraci nabidce Options
(Moznosti).

Na nepodporovaném zobrazovacim zarizenf s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).

Help>User Manual (Napovéda>Uzivatelska
prirucka) —Tato moznost bude aktivni pouze
po vybéru polozky User Manual (Uzivatelskd
prirucka) v rozeviraci nabidce Help (Ndpovéda).
Na nepodporovaném zobrazovacim zarizeni s
podporou DDC/Cl jsou k dispozici pouze karty
Help (Ndpovéda) a Options (Moznosti).



Help>Version (Napovéda>Verze) —Tato
moznost bude aktivni pouze po vybéru

polozky Version (Verze) v rozeviraci nabidce
Help (Ndpovéda). Na nepodporovaném
zobrazovacim zarfzen( s podporou DDC/CI
jsou k dispozici pouze karty Help (Ndpovéda) a
Options (MoZznosti).

Context Sensitive menu (Mistni nabidka)
Context Sensitive Menu (Mistni nabidka) je
ve vychozi konfiguraci Aktivovana. Nabidka
bude zobrazena po zaskrtnuti polozky Enable
Context Menu (Povolit mistni nabidku) v ¢asti
Options > podokno Preferences (Moznosti >

podokno Predvolby).

Context Menu (Mistni nabidka) obsahuje 3

polozky:

*  SmartControl Lite - po vybéru se zobrazf
obrazovka About (O) aplikaci.

*  Select Preset (Vybrat predvolbu) — nabizf
hierarchickou nabidku uloZenych predvoleb
pro okamzité pouziti. Aktudlné vybrand
predvolba je oznalena zaskrtnutim. V
rozeviraci nabidce Ize rovnéz vybrat polozku
Predvolby vyrobce.

» Tune Display (Ladéni zobrazeni) — otevre
ovlddaci panel SmartControl Lite.

Aktivovana nabidka hlavniho panelu

Nabidku hlavniho panelu Ize zobrazit klepnutim
pravym tlacitkem mysi na ikonu SmartControl
Lite na hlavnim panelu. Klepnutim levym
tlacftkem Ize spustit aplikaci.

Hlavni panel obsahuje pét polozek:

* Help (Ndpovéda) — pristup k souboru
s User Manual (uzivatelskou priruckou):
Otevr'e soubor s User Manual (uzivatelskou
priruckou) v okné vychoziho prohlizece.

* Technical Support (Odbornd pomoc) —
zobrazi stranku odborné pomoci.

* Check for Update (Vyhledat aktualizace) —
zobrazi Uvodn( stranku PDI a porovnad verzi
uzivatele s nejaktudlnéjsi dostupnou verzi.

* About (O aplikaci) — zobrazi podrobné
referencni informace: verze produktu,
informace o vydanf a ndzev produktu.

*  Exit (Konec) - ukonci SmartControl Lite

Chcete-li znovu spustit funkci SmartControl Lite,
vyberte polozku SmartControl Lite z nabidky
Program, poklepejte na ikonu na pracovni plose
pocitace nebo restartujte pocitac.

PHILIPS



Deaktivovana nabidka hlavniho panelu

Kdyz je hlavni panel deaktivovan ve slozce
Preference (Predvolby), je k dispozici pouze
¢ast EXIT (KONEC). Chcete-li funkci
SmartControl Lite zcela odstranit z hlavniho
panelu, deaktivujte polozku Run at Startup
(Spustit pri startu) v ¢asti Options>Preferences
(Moznosti>Predvolby).

& Pozndmka

Veskeré ilustrace v této Casti jsou pouze
orientacni.Verze softwaru SmartControl se
mUze zménit bez predchoziho upozornén.
Vzdy navstivte oficidini webové stranky Portrait
na adrese www.portrait.com/dtune/phl/enu/
index a stdhnéte si nejnovéjsi verzi softwaru
SmartControl.
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4. Technické udaje

Typ panelu LCD TFT-LCD

Podsvicenf LED

Velikost panelu 21,5" S (54,6 cm)

Pomér stran 16:9

Rozte¢ obrazovych bodu 0,248 x 0,248 mm

Jas 250 cd/m? or 200 cd/m?

SmartContrast 10.000.000:1

Kontrastni pomér (typ.) 1000:1 or 600:1 for 200 nitd

Doba odezvy (typickd) 5ms

Optimdin( rozlisenf 1920 x 1080 pri 60 Hz

Zorny Uhel 170° (H) / 160° (V) pri C/R>10
or 90° (H) / 65° (V) pri C/R>10 for 200 nitl

Barevnost displeje 16,/M

Vertikdlni obnovovacf frekvence | 56Hz - 76Hz

HorizontdInf frekvence 30kHz - 83kHz

sRGB ANO

223V5LSB/223V5LSW/223V5L5B2: VGA (analogovy)
DVI(digitalniHDCP) (nepovinny)
223V5LHSB/223V5LHSW/223V5LHSB2: VGA (analogovy)
HDMI(digitalniHDCP)

Vstup signdlu

Audio vstup/vystup Vystup zvuku HDMI(223V5LHSB/223V5LHSW)
Vstupnf signal Oddélend synchronizace, synchronizace podle zelené
Usnadnéni

Usnadnéni pro uZivatele AaUTO/Y /A 0/« /0K 0}

Anglictina, Némcina, Spanélstina, Francouzstina, Italstina,

iy meleiley QLD Madargtina, Holandtina, Portugalétina, Brazilskd portugalétina,
3 portug

Poltina, Rugtina, Svédztina, Fingtina, Turettina, Cetina,
Ukrajinstina, Zjednodusend ¢instina, Japonstina, Korejstina,
Rec“:tina(nepovinn\]), Tradi¢ni ¢instina(nepovinny)

Dalsi usnadnénf Zamek Kensington

Kompatibilita s technologif DDC/CI, sRGB, Windows 7/Windows 8/Vista/XP, Mac OSX,

Plug & Play Linux

Uchyt VESA 100x100 mm

Podstavec

Naklon -5/+20

223V5LHSB/223V5LHSW/223V5LHSB2:

Napajeni

19.66 W (typ.), 23.76 W (max.)for 223V5LHSB/223V5LHSW or

Zepnito 21.63W (typ.), 25.63W(max.)for 223V5LHSB2
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Spanek (Pohotovost) 0,5W

Vypnuto 0,5W

Indikdtor napdjent Zapnuto: Bild, Pohotovostn( rezim/rezim spanku: Bild (blikd)
Napdjenf Vypidleni, 100-240VAC, 50-60Hz

223V5LSB/223V5LSW/223V5LSB2:
Napajeni

Zapnuto

18,6W (typ.), 22.57W (max.) for 223V5LSB/223V5LSW
or 17.07W (typ.), 20,26 W (max.) for 223V5LSB2

Spanek (Pohotovost)

0,5W

Vypnuto 0,5W
Indikdtor napdjenf Zapnuto: Bil3, Pohotovostn( rezim/rezim spdnku: Bild (blikd)
Napdjen( Vypéleni, 100-240VAC, 50-60Hz

Rozméry
Vyrobek s podstavce (SxVxH)

503 x 376 x 213 mm

Vyrobek bez podstavce (SxVxH)
Hmotnost
Vyrobek s podstavcem

503 x 316 x 50 mm

2,605kg

Vyrobek bez podstavce

2,304kg

Provozni podminky

Shoda a normy
Prohldseni o shodé

Teplotni rozsah (provoz) 0°Caz 40 °C
Teplotni rozsah (mimo provoz) -20°C az 60°C
Relativni vihkost 20% az 80%

MTBF 30 000 hod

ROHS ANO

EPEAT Silver (www.epeat.net)
Balenf 100% recyklovatelny
Energy Star ANO

CE Mark, FCC Class B, EAC, SEMKO, BSMI, cETLus,
1509241-307, TCO Certified , INMETRO(Only for selective models)

Barva Cemé/Bila
Povrchova dprava Textura
& Poznamka
1. Certifikdt EPEAT Gold nebo Silver je platny pouze tam, kde spolecnost Philips zaregistruje produkt.

Informace o stavu registrace ve vasi zemi viz www.epeat.net.

N

www.philips.com/support.

Tyto Udaje se mohou zménit bez predchoziho ozndment. Stéhnéte si nejnovejsi verzi letdku z webu




4.1 Rezimy rozliseni a predvoleb

H Maximélni rozli$eni
1920 x 1080 pri 60 Hz (analogovy vstup)
1920 x 1080 pri 60 Hz (digitani vstup)

E1 Doporuéené rozliseni
1920 x 1080 pii 60 Hz (digitaini vstup)

Vodorovna Rozliseni Svisla
frekvence frekvence
(kHz) (Hz)
31,47 720 x 400 70,09
31,47 640 x 480 59,94
35,00 640 x 480 66,67
37,86 640 x 480 72,81
37,50 640 x 480 75,00
37,88 800 x 600 60,32
46,88 800 x 600 75,00
48,36 1024 x 768 60,00
60,02 1024 x 768 75,03
44,77 1280 x 720 59,86
63,89 1280 x 1024 60,02
79,98 1280 x 1024 75,03
5594 1440 x 900 59,89
70,64 1440 x 900 7498
65,29 1680 x 1050 59,95
67,50 1920 x 1080 60,00
=) Poznamka

Upozorfiujeme vds, Ze tento monitor funguje
nejlépe pri nativnim rozliseni 1920 x 1080 pr
60 Hz. Pro dosaZenf optimdin( kvality zobrazenf
dodrzujte toto doporucené rozlisent.

18



5. Rizeni spotieby

Pokud je v daném pocitaci nainstalovdn software
nebo videokarta vyhovujici normé DPM
organizace VESA, monitor dokdze automaticky
snizit svou spotrebu energie, neni-li pouzivan.
Pokud pocitac rozpozna vstup z kldvesnice,

mysi nebo jiného vstupniho zarfzeni, monitor se
automaticky ,,probudi*. Nasledujici tabulka uvadf
spotrebu energie a signalizaci této funkce pro

automatickou Usporu energie:

223V5LHSB/223V5LHSW/223V5LHSB2:

Definice rizenf spotreby

ReZim VESA| Video [ H-synch. | V-synch. | Spotieba energie | Barva indikétoru LED

19.66 W (typ.)for
223V5LHSB
Aktivnl | ZAP. | Ano Ano 1223V5LHSW Bild
or 21.63W (typ.)
for 223V5LHSB2

Spanek | VYP. | Ne Ne 05W (typ) B (blikd)

Vypnuto | VYP. - - 0,5W (typ.) VYP.

223V5LSB/223V5LSW/223V5LSB2:

Definice rizenf spotreby

Rezim VESA [ Video | H-synch. | V-synch. | Spotreba energie | Barva indikstoru LED

18,6W (typ.) for
223V5LSB
Aldtivni ZAP. Ano Ano 1223V5LSW Bild
or 17.07W (typ)
for 223V5LSB2

Spanek VYP. Ne Ne 0,5W (typ.) Bild (blikd)

Vypnuto | VYP. | - - 05W (typ) VYP,

Ndsledujic konfigurace se pouziva pri mérenf
energetické spotreby tohoto monitoru.

* Nativni rozlisent: 1920 x 1080

*  Kontrast: 50%

e Jas: 250 nitd or 200 nitd

» Barevnd teplota: 6500 K s pIné bilym

vzorkem

& Poznimka
Tyto Udaje se mohou zménit bez predchoziho
ozndment.
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6. Informace o regulaci

Lead-free Product

Lead free display promotes

@ environmentally sound recovery
ey and disposal of waste from electrical

and electronic equipment. Toxic

substances like Lead has been eliminated

and compliance with European community's

stringent RoHs directive mandating restrictions

on hazardous substances in electrical and

electronic equipment have been adhered to

in order to make Philips monitors safe to use

throughout its life cycle.

Congratulations!

This product is TCO Certified - for Sustainable
T

TCO Certified is an international
third party sustainability certificati-

on for IT products. TCO Certified.
ensures that the manufacture, use and recycling
of IT products reflect environmental, social and
economic responsibility. Every TCO Certified
product model is verified by an accredited inde-
pendent test laboratory.

This product has been verified to meet all the
criteria in TCO Certified, including:

* Corporate Social Responsibility
Socially responsible production - working
conditions and labor law in manufacturing
country

» Energy Efficiency
Energy efficiency of product and power
supply. Energy Star compliant, where
applicable

*  Environmental Management System
Manufacturer must be certified according
to either ISO 14001 or EMAS

*  Minimization of Hazardous Substances
Limits on cadmium, mercury, lead
& hexavalent chromium including
requirements for mercury-free products,
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halogenated substances and hazardous
flame retardants

*  Design for Recycling
Coding of plastics for easy recycling. Limit
on the number of different plastics used.

*  Product Lifetime, Product Take Back
Minimum one-year product warranty.
Minimum three-year availability of spare
parts. Product takeback

* Packaging
Limits on hazardous substances in product
packaging. Packaging prepared for recycling

*  Ergonomic, User-centered design
Visual ergonomics in products with a
display. Adjustability for user comfort
(displays, headsets) Acoustic performance
— protection against sound spikes
(headsets) and fan noise (projectors,
computers) Ergonomically designed
keyboard (notebooks)

* Electrical Safety, minimal electro-magnetic
Emissions Third Party Testing
All certified product models have been
tested in an independent, accredited
laboratory.
A detailed criteria set is available for download
at www.tcodevelopment.com, where you can
also find a searchable database of all TCO
Certified IT products.

TCO Development, the organization behind
TCO Certified, has been an international
driver in the field of Sustainable T for 20 years.
Criteria in TCO Certified are developed in
collaboration with scientists, experts, users

and manufacturers. Organizations around the
world rely on TCO Certified as a tool to help
them reach their sustainable [T goals. We are
owned by TCO, a non-profit organization
representing office workers. TCO Development
is headquartered in Stockholm, Sweden, with
regional presence in North America and Asia.

For more information, please visit
www.tcodevelopment.com



Tm

CERTIFIED

Technology for you and the planet

(Only for selective models)

EPEAT

(Wwww.epeat.net)

€ The EPEAT (Electronic
’ QQ' Product Environmental

& Assessment Tool) program

evaluates computer desktops,

laptops, and monitors based on 571 environ-
mental criteria developed through an extensive
stakeholder consensus process supported by
US EPA.

EPEAT system helps purchasers in the public
and private sectors evaluate, compare and
select desktop computers, notebooks and
monitors based on their environmental
attributes. EPEAT also provides a clear and
consistent set of performance criteria for the
design of products, and provides an opportunity
for manufacturers to secure market recognition
for efforts to reduce the environmental impact
of its products.

Benefits of EPEAT

Reduce use of primary materials
Reduce use of toxic materials

Avoid the disposal of hazardous waste EPEAT'S
requirement that all registered products meet
ENERGY STAR's energy efficiency specificati-
ons, means that these products will consume
less energy throughout their life.
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CE Declaration of Conformity

This product is in conformity with the following
standards

»  EN60950-1:2006+A11:2009+A1:20
10+A12:2011 (Safety requirement of
Information Technology Equipment).

»  EN55022:2010 (Radio Disturbance
requirement of Information Technology
Equipment).

e EN55024:2010 (Immunity requirement of
Information Technology Equipment).

*  EN61000-3-2:2006 +A1:2009+A2:2009
(Limits for Harmonic Current Emission).

»  EN61000-3-3:2008 (Limitation of Voltage
Fluctuation and Flicker) following provisions
of directives applicable.

e 2006/95/EC (Low Voltage Directive).

*  2004/108/EC (EMC Directive).

e 2009/125/EC (ErP Directive, EC No.
1275/2008 Implementing Directive
for Standby and Off mode power
consumption) and is produced by a
manufacturing organization on 1SO9000
level.

The product also comply with the following

standards

*  1SO9241-307:2008 (Ergonomic
requirement, Analysis and compliance test
methods for electronic visual displays).

*  GS EK1-2000:2011 (GS mark requirement).

»  prEN50279:1998 (Low Frequency Electric
and Magnetic fields for Visual Display).

e MPR-II (MPR:1990:8/1990:10 Low
Frequency Electric and Magnetic fields).

*  TCO CERTIFIED (Requirement for
Environment Labeling of Ergonomics,
Energy, Ecology and Emission, TCO: Swedish
Confederation of Professional Employees)
for TCO versions.



Energy Star Declaration

(www.energystar.gov)

As an ENERGY STAR® Partner, we
have determined that this product

meets the ENERGY STAR®
guidelines for energy efficiency.
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& Note

We recommend you switch off the monitor
when it is not in use for a long time.

Federal Communications Commission (FCC)
Notice (U.S. Only)

& This equipment has been tested and found
to comply with the limits for a Class B digital
device, pursuant to Part 15 of the FCC
Rules. These limits are designed to provide
reasonable protection against harmful
interference in a residential installation.

This equipment generates, uses and can
radiate radio frequency energy and, if not
installed and used in accordance with the
instructions, may cause harmful interference
to radio communications.

However, there is no guarantee that
interference will not occur in a particular
installation. If this equipment does cause
harmful interference to radio or television
reception, which can be determined by
turning the equipment off and on, the
user is encouraged to try to correct

the interference by one or more of the
following measures:

* Reorient or relocate the receiving antenna.

* Increase the separation between the
equipment and receiver.

» Connect the equipment into an outlet on
a circuit different from that to which the
receiver is connected.

»  Consult the dealer or an experienced
radio/TV technician for help.
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@ Changes or modifications not expressly
approved by the party responsible for
compliance could void the user's authority
to operate the equipment.

Use only RF shielded cable that was supplied
with the monitor when connecting this monitor
to a computer device.

To prevent damage which may result in fire or
shock hazard, do not expose this appliance to
rain or excessive moisture.

THIS CLASS B DIGITAL APPARATUS MEETS
ALL REQUIREMENTS OF THE CANADIAN
INTERFERENCE-CAUSING EQUIPMENT
REGULATIONS.

FCC Declaration of Conformity

Declaration of Conformity for Products Marked
with FCC Logo,

United States Only

rC

This device complies with Part 15 of the FCC
Rules. Operation is subject to the following
two conditions: (1) this device may not cause
harmful interference, and (2) this device must
accept any interference received, including
interference that may cause undesired
operation.

Commission Federale de la Communication
(FCC Declaration)

& Cet équipement a été testé et déclaré
conforme auxlimites des appareils
numériques de class B,aux termes de l'article
15 Des regles de la FCC. Ces limites sont
congues de facon a fourir une protection
raisonnable contre les interférences nuisibles
dans le cadre d'une installation résidentielle.

CET appareil produit, utilise et peut émettre
des hyperfréquences qui, si I'appareil n'est
pas installé et utilisé selon les consignes
données, peuvent causer des interférences


www.energystar.gov

nuisibles aux communications radio.
Cependant, rien ne peut garantir |'absence
d'interférences dans le cadre d'une
installation particuliere. Si cet appareil est
la cause d'interférences nuisibles pour

la réception des signaux de radio ou de
télévision, ce qui peut étre décelé en
fermant I'équipement, puis en le remettant
en fonction, |'utilisateur pourrait essayer de
corriger la situation en prenant les mesures
suivantes:

Réorienter ou déplacer I'antenne de
réception.

Augmenter la distance entre I'équipement
et le récepteur.

Brancher I'€quipement sur un autre circuit
que celui utilisé par le récepteur.

Demander l'aide du marchand ou d'un
technicien chevronné en radio/télévision.

Toutes modifications n'ayant pas recu
I'approbation des services compétents

en matiére de conformité est susceptible
d'interdire a l'utilisateur 'usage du présent
équipement.

N'utiliser que des cables RF armés pour
les connections avec des ordinateurs ou
périphériques.

CET APPAREIL NUMERIQUE DE LA CLASSE
B RESPECTE TOUTES LES EXIGENCES DU
REGLEMENT SUR LE MATERIEL BROUILLEUR
DU CANADA.
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EN 55022 Compliance (Czech Republic Only)

This dswice belongs to category B devices as described in EN 55022, unless it is specifi-
cally stated that it is a Class A devics on the speciication labal. The following appiies to
devices in Class A of EN 55022 (radius of protection up 1o 30 meters). The ussr of the
devics iz obliged to taks all staps necessary to remove sources of intarfarencs 1o tels-
communication or sther devicss.

Pokud neni na typovém Bithu pottate uvedeno, 26 spadé dodo tidy A podie EN 55022,
spada automaticky do thidy B podle EN 55022, Pro zafizen! zafazend do tFidy A (chranné
pésma 30m) podie EN 55022 platl nésleduficl. Dojde-li k rullan! telskamunikataich nebo
Finjich zafizeni je uZivatal povinnen provést takovd opatfgn, aby nseni odstranil,

Polish Center for Testing and Certification
Notice

The equipment should draw power from a
socket with an attached protection circuit (a
three-prong socket). All equipment that works
together (computer, monitor, printer, and so
on) should have the same power supply source.

The phasing conductor of the room's electrical
installation should have a reserve short-circuit
protection device in the form of a fuse with a
nominal value no larger than 16 amperes (A).

To completely switch off the equipment, the
power supply cable must be removed from the
power supply socket, which should be located
near the equipment and easily accessible.

A protection mark "B" confirms that the
equipment is in compliance with the protection

usage requirements of standards PN-93/
T-42107 and PN-89/E-06251.

Wymagama Polskugo Centrum Badan i Certyfi) kaqr
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North Europe (Nordic Countries) Information

Placering/Ventilation

VARNING:

FORSAKRA DIG OM ATT HUVUDBRYTARE
OCH UTTAG AR LATATKOMLIGA, NAR
DU STALLER DIN UTRUSTNING PAPLATS,

Placering/Ventilation

ADVARSEL:

SORG VED PLACERINGEN FOR, AT
NETLEDNINGENS STIK OG STIKKONTAKT
ER NEMT TILG/ANGELIGE.

Paikka/llmankierto

VAROITUS:

SIOITA LAITE SITEN, ETTA VERKKOJOHTO
VOIDAAN TARVITTAESSA HELPOSTI
IRROTTAA PISTORASIASTA.

Plassering/Ventilasjon

ADVARSEL:

NAR DETTE UTSTYRET PLASSERES, MA
DU PASSE PA AT KONTAKTENE FOR

ST@MTILF@RSEL ER LETTE A NA.

BSMI Notice (Taiwan Only)
HAZBERERIIEE |

Ergonomie Hinweis (nur Deutschland)

Der von uns gelieferte Farbmonitor entspricht
den in der "Verordnung Uber den Schutz vor
Schiden durch Rontgenstrahlen” festgelegten
Vorschriften.

Auf der Rickwand des Gerdtes befindet sich
ein Aufkleber, der auf die Unbedenklichkeit der
Inbetriebnahme hinweist, da die Vorschriften
Uber die Bauart von Stérstrahlern nach Anlage
a5 Abs. 4 der Réntgenverordnung erfilit
sind.

Damit Ihr Monitor immer den in der Zulassung
geforderten Werten entspricht, ist darauf zu
achten, dal3

1. Reparaturen nur durch Fachpersonal
durchgefiihrt werden.
2. nur original-Ersatzteile verwendet werden.

bei Ersatz der Bildréhre nur eine
bauartgleiche eingebaut wird.

Aus ergonomischen Griinden wird empfohlen,
die Grundfarben Blau und Rot nicht auf
dunklem Untergrund zu verwenden (schlechte
Lesbarkeit und erhdhte Augenbelastung bei zu
geringem Zeichenkontrast waren die Folge).
Der arbeitsplatzbezogene Schalldruckpegel
nach DIN 45 635 betrdgt 70dB (A) oder
weniger.

) ACHTUNG: BEIM AUFSTELLEN
DIESES GERATES DARAUF
ACHTEN, DAB NETZSTECKER UND
NETZKABELANSCHLUB LEICHT
ZUGANGLICH SIND.



China RoHS

The People's Republic of China released a
regulation called "Management Methods for
Controlling Pollution by Electronic Information
Products" or commonly referred to as China
RoHS. All products including CRT and Monitor
which are produced and sold for China market
have to meet China RoHS request.
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EU Energy Label

The European Energy Label informs you on the
energy efficiency class of this product. The gree-
ner the energy efficiency class of this product is
the lower the energy it consumes.

On the label, you can find the energy efficiency
class, the average power consumption of this
product in use and the average energy con-
sumption for 1 year.

SNote
The EU Energy Label will be ONLY applied on
the models bundling with HDMI and TV tuners.



7. Péce o zakazniky a zaruka

7.1 Postup pri vadnych pixelech
plochého panelu spolecnosti
Philips

Spolecnost Philips se snazi doddvat vyrobky
vyrobnich postup( vyroby v tomto odvétvi a
prosazuje prisnou kontrolu kvality. Defektim
obrazovych bodd nebo dil¢ich obrazovych
bodl u paneld TFT LCD, které se pouZzivajf
pro ploché monitory, se nicméné nékdy neda
zabranit. Zadny vyrobce nemuize zarudit, ze
vSechny panely budou bez defektd obrazovych
bodd, ale spole¢nost Philips zarucuje, ze kazdy
monitor s neprijatelinym poctem defektl bude
v rdmci zdruky opraven nebo vymeénén.Tento
text vysvétluje jednotlivé druhy defektd na
pixelech a urcuje Unosnou uroven chybovosti
pro kazdy druh. Aby bylo mozné uplatnit zarucnf
opravu nebo vyménu, musi pocet defektnich
obrazovych bodd panelu TFT LCD presdhnout
tuto droverl Unosnosti. Na monitoru napriklad
nesmf byt vice defektnich dil¢ich obrazovych
bodd nez 0,0004 %. Déle, protoze nékteré typy
kombinaci vad pixeltl jsou lépe postrehnutelné
nez jiné, stanovuje pro né spolecnost Philips
jesté vetsi ndroky na kvalitu. Tato norma se
dodrzuje celosvetove.

subpixely subpixely subpixely

vy
pixelly

Pixely a subpixely

Pixel, neboli obrazovkovy bod, se skldda ze trf
subpixeld v zakladnich barvéch Cervené, zelené a
modré. Kdyz je mnoho pixeld pohromadg, tvorf
obraz. Kdyz viechny subpixely uréitého pixelu
svitf, jevi se tyto tfi subpixely spole¢né jako
jediny bily pixel. Kdyz jsou viechny tmavé, jevl
se tyto tfi subpixely jako jeden Cerny pixel. Dalsf
kombinace rozsvicenych a tmavych subpixell se
jevi jako pixely rdznych barev.
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Druhy pixelovych vad

Vady pixell a subpixeld se na obrazovce
projevuji rznymi zplsoby. Existuji dva druhy
vad pixelu a v rdmci téchto druhd je nékolik
typd subpixelovych vad.

Defekty svétlych bodu

Defekty svétlych bodl se projevuji jako
obrazové body nebo dil¢i obrazové body, které
vzdy sviti nebo jsou 'aktivni'. Svétly bod je dilef
obrazovy bod, ktery vystupuje z obrazovky, kdyz
je na monitoru zobrazena tmavé plocha. Existujf

nasledujici typy defektl svétlych bodd:

Jeden Cerveny, zeleny nebo modry subpixel

¢

Dva soundlezicl subpixely:
- lerveny + modry = fialovy
- Clerveny + zeleny = Zluty

- zeleny + modry = svétle modry

Tri soundlezicl rozsvicené subpixely (jeden bily
pixel).



& Pozniamka

Cerveny nebo modry svétly bod musi byt o
vice nez 50 procent jasnéjsi, nez sousedni body;
zeleny svétly bod je o 30 procent jasngjsi, nez
sousedn( body.

Defekty tmavych bodu

Defekty tmavych bodu se projevuji jako
obrazové body nebo dil¢i obrazové body, které
nikdy nesvitf nebo jsou ,,neaktivni. Tmavy bod je
dil¢i obrazovy bod, ktery vystupuje z obrazovky,
kdyZ je na monitoru zobrazena svétld plocha.

Existuji nasledujici typy defektd tmavych bodd:

Vzdalenost pixelovych vad

Protoze vady pixell a subpixell stejného

typu, které se vyskytuji blizko sebe, mohou byt
patrnéjsi, urcuje spolecnost Philips i tolerance na
vzdalenost vad pixeld.

Tolerance vad pixell

Aby bylo mozné uplatnit opravu nebo vyménu
kvlli defektnim obrazovym bodim v zdru¢nf
dobé, musf panel TFT LCD plochého monitoru
Philips vykazovat defekty obrazovych bodl
nebo dil¢ich obrazovych bod(, které prekracujf
tolerance uvedené v ndsledujicich tabulkdch.

KAZY JASNYCH BODU

PRIJATELNY POCET VAD

1 trvale svitici bod 3
2 sousedni trvale svitici body 1
3 sousednl trvale sviticf body (nebo 1 trvale svitici bily bod) 0
Vzdalenost mezi dvéma kazy jasnych bodi* >15 mm
Celkovy pocet kazl jasnych bodd viech typl 3

KAZY CERNYCH BODU
1 tmavy bod

PRIJATELNY POCET VAD
5 nebo méné

2 sousedni tmavé body

2 nebo méné

3 sousedni tmavé body 0
Vzddlenost mezi dvéma kazy cemych bodi* >15 mm
Celkovy pocet kazt ¢ernych bodd viech typl 5 nebo méné

KAZy bodl celkem

PRIJATELNY POCET VAD

Celkovy pocet kazt jasnych nebo ¢ernych bodut viech typl

5 nebo méné

& Poznamka

1. 1 nebo 2 sousedni vadné body (1 barva) = 1 vadny bod

2. Tento monitor je kompatibilni se standardem ISO 9241-307. ( ISO 9241-307: Ergonimicky
pozadavek, analyza a metody testovani shody pro elektronickd zobrazovaci zarizen)

3. Norma 1SO9241-307 je naslednikem drivéjsi normy ISO13406, kterd byla zrusena organizaci 1ISO
(International Organisation for Standardisation) ke dni: 2008-11-13




7.2 Péce o zakazniky & zaruka

Podrobné informace o zdruce a pozadavku na dodatecnou podporu platné pro vasi oblast najdete na
webu www.philips.com/support. Rovnéz muizete kontaktovat mistni centrum péce o zdkazniky na nize
uvedenych telefonnich &islech.

Kontaktni informace pro oblast ZAPADNI EVROPY:

Zemé CSP Horka linka Cena Oteviraci doba

Austria RTS +43 0810 000206 €007 Mon to Fri: 9am - 6pm
Belgium Ecare +32 078 250851 €0.06 Mon to Fri: 9am - 6pm
Cyprus Alman 800 92 256 Free of charge | Mon to Fri: 9am - 6pm
Denmark Infocare +45 3525 8761 Local call tariff | Mon to Fri: 9am - 6pm
Finland Infocare +358 09 2290 1908 | Local call tariff [ Mon to Fri: 9am - 6pm
France Mainteq +33 082161 1658 €0.09 Mon to Fri: 9am - 6pm
Germany RTS +49 01803 386 853  |€0.09 Mon to Fri: 9am - 6pm
Greece Alman +30 00800 3122 1223 | Free of charge [ Mon to Fri: 9am - 6pm
Ireland Celestica +353 01 601 1161 Local call tariff | Mon to Fri: 8am - 5pm
Italy Anovo ltaly | +39 840 320 041 €0.08 Mon to Fri: 9am - 6pm
Luxembourg Ecare +352 26 84 30 00 Local call tariff | Mon to Fri: 9am - 6pm
Netherlands Ecare +31 0900 0400 063 € 0.10 Mon to Fri: 9am - 6pm
Norway Infocare +47 2270 8250 Local call tariff | Mon to Fri: 9am - 6pm
Poland MSI +48 0223491505 Local call tariff | Mon to Fri: 9am - 6pm
Portugal Mainteq 800 780 902 Free of charge  [Mon to Fri: 8am - 5pm
Spain Mainteq +34 902 888 785 €0.10 Mon to Fri: 9am - 6pm
Sweden Infocare +46 08 632 0016 Local call tariff | Mon to Fri: 9am - 6pm
Switzerland ANOVO CH [ +41 02 2310 2116 Local call tariff | Mon to Fri: 9am - 6pm
United Kingdom | Celestica +44 0207 949 0069 Local call tariff | Mon to Fri: 8am - S5pm

Kontaktni informace pro Cinu:

Cislo zakaznické péce

4008 800 008

Telefonni stredisko

China PCCW Limited

Kontaktni informace pro SEVERNI AMERIKU:

Telefonni stredisko

Cislo zékaznické péce
(877) 835-1838

USA

Canada

EPl-e-center

EPl-e-center (800) 479-6696
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Kontaktni informace pro oblast STREDNI A VYCHODNI EVROPY:

Telefonni

CSP

Cislo zakaznické péce

stredisko

+37517 217 3386

Belarus NA IBA +375 17 217 3389
Bulgaria NA LAN Service +359 2 960 2360
Croatia NA MR Service Ltd +385 (01) 640 1111
Czech Rep. NA Asupport 420 272 188 300
T
Georgia NA Esabi +995 322 91 34 71
+36 1 814 8080(General)
Hungary NA Profi Service +36 1814 8565(For AOC&Philips
only)
Kazakhstan NA Classic Service llc. | +7 727 3097515
A
Latvia NA ServiceNet LV _3;1 ggzggzz
Lithuania NA UAB Servicenet Ig;g ;4710%%(:31862‘(5?;%325)
Macedonia NA AMC +389 2 3125097
Moldova NA Comel +37322224035
Romania NA Skin +40 21 2101969
Russia NA CPS +7 (495) 645 6746
Serbia&Montenegro | NA Kim Tec d.o.o. +381 11 20 70 684
Slovakia NA Datalan Service +421 2 49207155
Slovenia NA PC Hand +386 1 530 08 24
the republic of Belarus | NA ServiceBy + 37517 284 0203
Turkey NA Tecpro +90 212 444 4 832
Ukraine NA Topaz +38044 525 64 95
Ukraine NA Comel +380 5627444225

Kontaktni informace pro oblast LATINSKE AMERIKY:

Telefonni stredisko

Brazil

Argentina

Vermont

Cislo zakaznické péce
0800-7254101

0800 3330 856
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Kontaktni informace pro oblast APMEA:

Zemé

Australia

ASP
AGOS NETWORK PTY LTD

Cislo zakaznické pé&e
1300 360 386

Oteviraci doba
Mon.~Fri. 9:00am-5:30pm

New Zealand

Visual Group Ltd.

0800 657447

Mon.~Fri. 8:30am-5:30pm

Hong Kong:

C Macau:Tel: (853)-0800-987 - ~OP
. Tel: 1 800 425 6396 .
India REDINGTON INDIA LTD SMS: PHILIPS 1o 56677 Mon.~Fri. 9:00am-5:30pm
+62-21-4080-9086 (Customer _ ; An
donesia PT. CORMIC SERVISINDO | Hotline) :43(-)86-;;?608'30_1 200;
PERKASA +6278888—O1 -9086 (Customer Fri. 08:30-11:30: 13:00-17:30
Hotline)
. Mon.~Fri. 9:00am-5:30pm
Korea Alphascan Displays, Inc 1661-5003 Sat. 9:00am-1:00pm
. ; Mon.~Fri. 8:15am-5:00pm
Malaysia R-Logic Sdn Bhd +603 5102 3336 Sat. 8:30am-12:30am
Pakistan TVONICS Pakistan +92-213-6030100 Sun.~Thu. 10:00am-6:00pm
Philips Electronics Singapore 2 G _
Singapore Pte Ltd (Philips Consumer Care | (65) 6882 3966 Mon.~Fri. 9:00am-6:00pm
Sat. 9:00am-1:00pm
Center)
Taiwan FETEC.CO 0800-231-099 Mon.~Fri. 09:00 - 18:00
Thailand Axis Computer System Co. | 01 934.5498 Mon.~Fri. 8:30am~05:30pm

Ltd.

South Africa

Computer Repair Technologies

011 262 3586

Mon.~Fri. 8:00am~05:00pm

Israel Eastronics LTD 1-800-567000 Sun.~Thu. 08:00-18:00
+84 8 38248007 Ho Chi Minh
FPT Service Informatic City =4 @ ) :
Vietnam Company Ltd. - Ho Chi Minh | +84 5113.562666 Danang City [1\/]7090 SZI' 288:1 %88 13:30-
City Branch +84 5113.562666 Can tho o '
Province
Shllppines || A0 Bty Gl (02) 655-7777; 6359456 Mon.~Fri. 8:30am~5:30pm
Solutions ,Inc.
Armenia
Azerbaijan
Georgia Firebird service centre +97 14 8837911 Sun.~Thu. 09:00 - 18:00
Kyrgyzstan
Tajikistan
Uzbekistan | 2ONike Plus Private Enterprise | | gq6-1 784650 Mon.~Fri. 09:00 - 1800

Ltd

Turkmenistan

Technostar Service Centre

+(99312) 460733, 460957

Mon.~Fri. 09:00 - 18:00

Japan

T4 SAE=HK— W
R— B Z—

0120-060-530

Mon.~Fri. 10:00 - 17:00
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8. Odstranovani probléma a
Casté dotazy

8.1 Odstranovani problému

Na této strance jsou uvedeny problémy,
které mdze odstranit uzivatel. Pokud problém
pretrvdvd i po vyzkousenf téchto resent,
kontaktujte zdstupce sluzeb pro zdkazniky
spolecnosti Philips.

El Bé&iné problémy

Zidny obraz (indikitor LED napajeni nesviti)

»  Zkontrolujte, zda je napdjec( kabel pripojen
k elektrické zdsuvce a do zadnf ¢asti
monitoru.

*  Nejdrive zkontrolujte, zda se vypinac na
predni strané monitoru nachdzi ve OFF
(VYPNUTE) poloze a stisknéte jej do ON
(ZAPNUTE) polohy.

Zadny obraz (indikator LED napajenti je bily)

*  Zkontrolujte, zda je zapnuty pocitac.

»  Zkontrolujte, zda je kabel signdlu rddné
pripojen k pocitadi.

»  Zkontrolujte, zda nejsou ohnuté koliky na
pripojovac( strané kabelu monitoru. Pokud
ano, opravte nebo vymérite kabel.

*  Pravdépodobné je aktivovdna funkce rizenf
spotreby

Obrazovka rika

Attention

Check cable connection

» Zkontrolujte, zda je kabel monitoru fddné
pripojen k pocitaci. (Rovnéz viz Strucnd
prirucka).

*  Zkontrolujte, zda nejsou ohnuté koliky
kabelu monitoru.

»  Zkontrolujte, zda je zapnuty pocital.

Tlacitko AUTO nefunguje
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Automatickd funkce je pouZitelnd pouze
v rezimu VGA-analogovy. Pokud vysledek
neni uspokojivy, mizete provést rucnf
Upravy prostrednictvim nabidky OSD.

€& Pozniamka
Automatickd funkce nenf pouzitelnd v
rezimu DVI-digitdIni, protoze je zbytecnd.

Viditelné znamky koure nebo jiskreni

*  Neprovddéjte zddné kroky pro odstrariovanf
problémd

*  Pro zajisténi bezpecnosti ihned odpojte
monitor od zdroje napéjenf

* |hned kontaktujte zdstupce sluzeb pro
zdkazniky spolecnosti Philips.

E1 Problémy se zobrazenim

Obraz neni vystredén

*  Upravte polohu obrazu pomoci funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Upravte polohu obrazu pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platna
pouze v rezimu VGA.

Obraz se chvéje na obrazovce

»  Zkontrolujte, zda je kabel signdlu rddné a
bezpecné pripojen ke grafické desce nebo k
pocitaci.

Dochazi ke svislému blikani

*  Upravte polohu obrazu pomocf funkce
,Auto” v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Féze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddaci prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Dochazi k vodorovnému blikani




*  Upravte polohu obrazu pomocf funkce
,Auto' v hlavnich ovlddacich prvcich OSD.

*  Omezte svislé pruhy pomoci polozek
Phase/Clock (Faze/frekvence) v &asti Setup
(Nastaveni) v OSD Main Controls (Hlavnf
ovlddac(i prvky OSD). Tato funkce je platnd
pouze v rezimu VGA.

Obraz je rozmazany, nevyrazny nebo prilis
tmavy
*  Upravte kontrast a jas na obrazovce OSD.

,Dosvit", ,vypaleni* nebo ,,zobrazeni duchi*

zlstane po vypnuti napéjeni.

*  Dlouhodobé neprerusované zobrazenf
nehybného nebo statického obrazu mize
zpUsobit ,,vypdleni* obrazovky, rovnéz
zndmé jako ,,dosvit" nebo ,,zobrazeni
duchl. ,Vypéleni*, ,dosvit"* nebo
,,zobrazeni duchd" je dobre zndmy jev
u technologie paneld LCD. V mnoha
pripadech ,vypdlen(”, , dosvit"* nebo
,,zobrazenf duchd" postupné zmizf po
urcité dobé mimo provoz.

* Pred ponechdnim monitoru bez dozoru
vzdy aktivujte spori¢ obrazovky.

* Bude-li na vaSem monitoru LCD zobrazen
nemeénici se staticky obsah, vzdy aktivujte

aplikaci pro pravidelnou obnovu obrazovky.

* Vaziné priznaky ,vypdleni*, ,dosvitu' nebo
,,zobrazenf duchli" nezmizi a nelze je
opravit. Na vySe uvedené poskozeni se
nevztahuje zdruka.

Obraz je zdeformovany. Text je nejasny nebo

rozmazany.

* Nastavte rozliSenf zobrazeni pocitace
na stejny rezim, v jakém se nachdzf
doporucené nativni rozliSenf obrazovky
monitoru.

Na obrazovce se objevuji zelené, cervené,

modré, tmavé a bilé tecky

»  Zbyvajici body jsou normdlnf viastnosti
tekutych krystald pouzivanych soucasnou
technologil. Dalsi podrobnosti viz pravidla
pro obrazové body.
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Svétlo indikatoru ,,napajeni* je prilis silné a

rusi

* MdZete nastavit intenzitu svétla indikdtoru
,napdjeni* v ¢asti Power LED (Indikdtor
LED napdjeni) v &asti Setup (Nastaven)
v OSD Main Controls (Hlavni ovlddacf
prvky nabidky OSD).

Potrebujete-li dalsi pomoc, viz seznam
Informacni strediska pro zdkazniky a kontaktujte
zéstupce sluzeb pro zdkazniky spolecnosti
Philips.

8.2 Obecné casté dotazy

OTAZKA 1: Kdyz nainstaluji sviij monitor, co
mam udélat, kdyz se na obrazovce
zobrazi zprava ,,Cannot display this
video mode* (Tento rezim videa
nelze zobrazit)?

Doporucené rozliseni pro tento

monitor: 1920 x 1080 pri 60 Hz.

*  Odpojte viechny kabely, potom pripojte
pocita¢ k monitoru, ktery jste pouzili predtim.

* V Start Menu (nabidce Start) operacniho
systému Windows vyberte Settings/Control
Panel (Nastaveni/Ovlddaci panely). V okné
Control Panel (Ovlddaci panely) vyberte
ikonu Display (Zobrazenf). Na panelu Display
Control (Zobrazeni — vlastnosti) vyberte kartu
,Settings' (Nastaveni). Na karté nastaven(

v poli ozna¢eném ,,desktop area” (pracovni
plocha) presurite posuvnik na 1920 x 1080
obrazovych bodu.

*  Klepnéte na,, Advanced Properties' (Upresnit),
nastavte polozku Refresh Rate (Obnovovact
frekvence) na 60 Hz a potom klepnéte na OK.

*  Restartujte pocitac a zopakovanim kroku 2 a
3 ovérte, zda je pocita¢ nastaven na 1920 x
1080 pri 60 Hz.

*  Vypnéte pocitac, odpojte stary monitor a
znowu pripojte monitor LCD Philips.

»  Zapnéte monitor a potom zapnéte pocitac.

Odpovéd:

OTAZKA 2: Jaki je doporuéena obnovovaci
frekvence monitoru LCD?
Doporucend obnovovaci frekvence
u monitort LCD je 60 Hz. V pripadé

jakéhokoli ruseni na obrazovce ji

Odpovéd:



OTAZKA 3:

Odpovéd:

OTAZKA 4:
Odpovéd:

OTAZKA 5:

Odpovéd:

OTAZKA 6:

Odpovéd:

OTAZKA 7:

Odpovéd:

mUZete nastavit na 75 Hz a uvidite,
zda ruseni zmizi.

Co jsou soubory .inf a .icm na disku
CD-ROM? Jak Ize nainstalovat
ovladace (.inf a .icm)?

Jednd se o soubory ovladace
monitoru. Pri instalaci ovladacl
postupujte podle pokyn( v
uzivatelské prfrucce. Pri prvni instalaci
bude pocita¢ pravdépodobné
pozadovat ovladace monitoru
(soubory .inf a .icm) nebo disk s
ovladaci. Postupujte podle pokynl a
vlozte (doprovodny disk CD-ROM),
ktery je soucdstf této sady. Ovladace
monitoru (soubory .inf a .icm)
budou nainstalovany automaticky.

Jak mam upravit rozliseni?
Dostupna rozliseni uréuje grafickd
karta/ovladac grafiky a monitor.
Pozadované rozliseni mdzete vybrat
v &asti Control Panel (Ovlddacf
panely) systému Windows® v &4sti
,Display properties" (Zobrazenf -
vlastnosti).

Co kdyz se béhem nastaveni
monitoru ztratim prostrednictvim
nabidky OSD?

Jednoduse stisknéte tlacitko OK a
potom volbou ,,Reset" (Obnovit)
obnovte vSechna plvodn( nastavenf
vyrobce.

Je obrazovka LCD odolna proti
poskrabani?

Obecné se doporucuje nevystavovat
povrch panelu nadmémym uderim
a chrénit jej pred ostrymi nebo
tupymi predméty. Pri manipulaci

s monitorem nevyvijejte na povrch
panelu Zddny tlak ani silu. Mohlo by
to negativné ovlivnit vase zarucnf
podminky.

Jak Ize distit povrch monitoru
LCD?
Pro bézné cisténi pouzijte Cisty
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a mekky hadrik. Pro ddkladné
cisténi pouzijte izopropyl
alkohol. Nepouzivejte zddnd jind
rozpoustédla, jako etylalkohol,
etanol, aceton, hexan atd.

OTAZKA 8: Lze ménit nastaveni barev
monitoru?
Odpovéd:  Ano, nastaveni barev mizete zménit

prostrednictvim nabidky OSD podle
nasledujicich krokd:

»  Stisknutim tlacitka ,,OK" zobrazte nabidku
OsD.

+  Stisknutim tlacftka ,,Down" (Sipka dolti)
vyberte volbu ,,Color” (Barva) a stisknutim
tlacitka ,,OK" prejdéte na nastavenf barev. K
dispozici jsou tfi nastaven( (viz nize).

1.

Color Temperature (Teplota barev):

k dispozici je dvou nastaveni: 6500K a
9300K. Pri nastaven( v rozsahu 6500K
vypadajf barvy na panelu ,teplé s
cervenobilym barevnym ténem", zatimco
pri nastaveni teploty 9300K vypadajf
barvy na panelu ,,studené s modrobilym
barevnym ténem®.

sRGB: standard pro zajisténi spravné
prenosu barev mezi rliznymi zarizenimi
(napr:. digitalni fotoapardty, monitory,
tiskdrny, skenery atd.)

User Define (Uzivatelské): uzivatel si mize
zvolit vlastni nastaveni barev upravenim
cervené, zelené a modré slozky.

© Poznimka:

Méreni svétla barvy, které vyzaruje predmét pri
zahrivani. Toto mérenf je vyjadieno v absolutnim
meéritku (stupné Kelvina). Nizsi teploty Kelvina,
napriklad 2004K, jsou cervené; vys3i teploty, jako
napriklad 9300K; jsou modré. Neutrdlni teplota je
bild pri 6504K.

OTAZKA 9:

Odpovéd:

Lze pFipojit tento monitor LCD
k libovolnému poéitaci, pracovni
stanici nebo pocitaci Mac?
Ano.Vsechny monitory LCD
Philips jsou plné kompatibilni se
standardnimi pocitaci, pocitaci
Mac a pracovnimi stanicemi. Pro
pripojeni monitoru k systému
Mac mUze byt zapotrebi kabelovy



OTAZKA 10:

Odpovéd:

OTAZKA 11:

Odpovéd:

D Vystraha

adaptér. Dal3i informace vdm
poskytne nejblizsi obchodnf
zastupce Philips.

Jsou monitory Philips LCD
vybaveny technologii Plug-and-
Play?

Ano, tyto monitory jsou
kompatibilni s technologi Plug-
and-Play v opera¢nim systému
Windows 7/Windows 8,Vista, XP.
NT, Mac OSX a Linux.

Co znamena Ipéni obrazu,
vypaleni obrazu, dosvit nebo
,,duch” v souvislosti s panely
LCD?

Dlouhodobé neprierusované
zobrazeni nehybného nebo
statického obrazu mdzZe zpUsobit
,vypdleni™ obrazovky, rovnéz
znamé jako ,,dosvit"* nebo
,zobrazeni duchl". ,Vypalenf,
,dosvit"* nebo ,,zobrazenf duchi*
je dobre zndmy jev u technologie
paneld LCD.V mnoha pripadech
,vypdleni”,, dosvit" nebo
.zobrazenf duchd" postupné zmizf
po urcité dobé mimo provoz.
Pred ponechadnim monitoru bez
dozoru vzdy aktivujte sporic
obrazovky.

Bude-li na vasem monitoru LCD
zobrazen neménici se staticky
obsah, vzdy aktivujte aplikaci pro
pravidelnou obnovu obrazovky.

Selhanf aktivace sporice obrazovky nebo aplikace
pro pravidelné aktualizovani obrazovky mize mit
za nasledek vazné priznaky ,,vypéleni”, ,,dosvitu"
nebo ,,zdvojeného dosvitu", které nezmizi a
nelze je opravit. Na vySe uvedené poskozen se
nevztahuje zdruka.

OTAZKA 12: Proé se na displeji nezobrazuje

Odpovéd:

ostry text a pro¢ maji
zobrazené znaky zubaté okraje?
V&s monitor nejlépe pracuje pri
svém nativnim rozlisenf 1920

34

x 1080 pri 60 Hz. Pouzivejte
toto rozliseni pro dosazenf
optimalniho zobrazen.
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